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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license.

Copyright Notices

© Copyright 2003 - 2007 Hewlett-Packard Development Company, L.P.

Trademark Notices

Java™ is a U.S. trademark of Sun Microsystems, Inc.

Oracle® is a registered U.S. trademark of Oracle Corporation, Redwood City, California. 

UNIX® is a registered trademark of The Open Group.

Windows® and Windows NT® are U.S. registered trademarks of Microsoft Corporation. 
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Documentation Updates

This guide’s title page contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

To check for recent updates, or to verify that you are using the most recent edition of a document, go to:

http://ovweb.external.hp.com/lpe/doc_serv/ 

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details.

The following table indicates changes made to this document since the APR07 release.  

Chapter Changes

Chapter 1 Minor updates re copy policy enhancement. 

Chapter 2 Minor updates.

Chapter 3 Minor updates.

Chapter 4 Added introduction to setting up a distributed system.

Appendix B Added list of PI Report Packs
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Support

You can visit the HP software support web site at:

http://support.openview.hp.com/support.jsp 

HP Software online support provides an efficient way to access interactive technical support tools. As a valued 
support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a 
support contract.

To find more information about access levels and HP Passport, go to:

http://support.openview.hp.com/new_access_levels.jsp 
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1 Overview
This chapter covers the following topics:

• Introduction to Performance Insight

• The ATM Report Pack (and enhancements in version 3.3)

• Data collection

• Folders and reports

• Options for customizing reports

• Sources for additional information

Introduction to Performance Insight

Performance Insight is a performance management application that collects data from many 
sources, performs in-depth trend analysis, maintains performance baselines, and provides 
users with convenient, web-based reporting. Following is a partial list of product features:

• Distributed architecture

• Easy to scale (supports data collection from thousands of agents)

• CODA/OVPA agent support

• Multi-company security model

• Data warehousing

• Near Real Time reporting

• Forecasting 

• Extensive aggregation (by day, week, month; by location, by customer)

• Thresholding and alerting

• Easy identification of bottlenecks

• Easy assessment of capacity trends

• Accurate and timely documentation for management

• Integration with NNM

• Integration with OVO

The reporting solutions created for Performance Insight cover many areas of business 
technology optimization. For a list of reporting solutions organized by technology, see 
Appendix B, PI Report Packs.
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ATM Report Pack

The ATM Report Pack installs on OVPI. Once installed, this package directs OVPI to process 
collected data, perform various calculations, and display results in report templates. The 
reports will help you spot problems, rank the performance of PVCs, ports, and SVCs, and 
estimate what performance will be like 30, 60, and 90 days from now. Following are some of 
the questions the ATM Report Pack will help you answer:

• Is the network providing an acceptable level of service?

• Which PVCs and ports are utilized the most? 

• Could my underutilized PVCs and ports handle more traffic?

• Are errored and dropped cells taking place during excessive utilization?

• Is there a substantial difference between ingress and egress utilization?

• Which PVCs and ports are likely to degrade network performance?

• Are SVC switches handling requests for connections?

• How does performance compare customer-by-customer, or region-by-region?

Version 3.3 includes a copy policy enhancement that makes it easier to set up a distributed 
system. The enhancement involves changes to Datapipe Manager and the addition of a copy 
policy import file. Datapipe Manager parses the copy policy import file when you install the 
report pack on the central server. Parsing the file creates copy policies. You are no longer 
required to create copy policies yourself using the Management Console. Instead, your only 
task related to copy policies is to verify that the copy policies you need already exist. 

Version 3.3 includes the following upgrade package:

• UPGRADE_ATM_21_to_33

For details about defect fixes, see Appendix A, Version History.

Data Collection

The datapipes created for the ATM Report Pack are designed for two kinds of users:

• Service providers

• Organizations that lease services from a service provider

A service provider will use vendor-specific datapipes to collect data from ATM switches. An 
organization that is leasing services will collect data from edge devices and also from ATM 
switches if such devices exist within the customer’s private network. To collect data from 
these devices, install the ATM ifEntry Datapipe.

The following table provides a list of switch vendors, vendor-specific datapipes, and 
vendor-specific preprocessors. 

Vendor Datapipe Preprocessor

Cisco Cisco ATM Datapipe None

Marconi/Fore Fore ATM Datapipe
Fore ATM Channel Datapipe

None
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Following is a partial list of the statistics gathered by the vendor-specific datapipes:

• Differentiated cell counts per-PVC

• ATM-specific errors

• Differentiated discard statistics

• Statistics for sustained cell rate (SCR)

• Statistics for peak cell rate (PCR)

ATM ifEntry Datapipe 1.3

The ATM ifEntry Datapipe collects MIB-II ifEntry and ifxEntry data from SNMP manageable 
devices. The ATMifEntry Datapipe performs a raw2delta on rate data and maps the results to   
ATM Report Back base tables. The ATM ifEntry Datapipe has these features:

• Re-indexing support (derived from the Interface Discovery Datapipe)

• Directed-instance polling, also known as per-instance polling

• High capacity counters whenever values exceed 32 bits

• Synchronized polling with Network Node Manager

The ATM ifEntry Datapipe is a prerequisite for the Cisco ATM Datapipe. If you select the 
Cisco ATM Datapipe for installation, Package Manager will install the ATM ifEntry Datapipe 
for you, automatically. The ATM ifEntry Datapipe polls MIB-2 ifEntry statistics and 
populates the ATM Report Pack base tables. The Cisco ATM Datapipe polls the Cisco-specific 
table and populates the same base tables with statistics for virtual circuits and virtual path 
identifiers in the ATM sub-layers.

The ATM ifEntry Datapipe requires no configuration. For details about optional configuration 
steps, refer to the ATM ifEntry Datapipe User Guide.

Preprocessors for Stratacom and Newbridge Devices

The ATM devices produced by the vendors in the preceding table store performance data in 
proprietary MIBs. Although OVPI can use vendor-specific datapipes to import the flat files 
produced by Cisco, Fore, and Ascend devices, OVPI cannot import a flat file made by a 
Stratacom or Newbridge device without processing the file. If you intend to collect data from 
Stratacom or Newbridge devices, installing a preprocessor is mandatory. Both preprocessors 
ship with the report pack CD-ROM. The user guides for the preprocessors, listed below, cover 
installation and configuration:

• Stratacom Preprocessor User Guide

• Newbridge Preprocessor User Guide

Lucent/Ascend Ascend ATM Datapipe None

Alcatel/Newbridge Newbridge ATM Datapipe Newbridge Preprocessor

Cisco/Stratacom Stratacom ATM Datapipe Stratacom Preprocessor

Vendor Datapipe Preprocessor
Overview 9



Folders and Reports

The ATM Report Pack contains three folders and 49 reports. The folders are:

• PVC (22 reports) 

— Peak cell rate (PCR)

— Sustained cell rate (SCR)

— Percentage of dropped cells

• Port (16 reports)

— Number of cell bits transmitted

— Utilization

— Discards

— Errors

• SVC (11 reports)

— Success rate of call attempts

— Number of calls per second

For a list of the reports in each folder, see the report chapters (7, 8, and 9). A brief description 
of each generic report follows.

Capacity Planning. Allows you to assess growth, balance traffic, and plan for increases or 
decreases in utilization. Shows PVC endpoints and ports that are projected to be overutilized 
or underutilized in the near future. 

Configuration. Indicates which PVCs and ports have property columns that are undefined. 
If required fields are not defined appropriately, utilization values may be incorrect. 

Daily Availability. Provides service level agreement statistics on a daily and monthly basis. 
These statistics show the percentage of time that managed elements were functional. 
Statistics include average hourly, daily, and monthly port and PVC endpoint availability. 

Executive Summary. Presents summary views of PVC endpoints, SVCs, or ports by 
customer or by region. Graphs show total in and out traffic, errors, discards, and percentage of 
volume based on Quality of Service types. 

Forecast. Enables you to anticipate network growth. Points out possible hot spots that are 
likely to occur within the next 30 days. Delivers a view into the future so that staff can take 
whatever steps are necessary to prevent problems from arising. 

Hot Spots. Identifies specific elements that consistently exceeded a threshold parameter 
during the previous day. Helps pinpoint problems. Grade of Service charts correlate 
exceptions and overutilization, allowing network managers to anticipate the impact on 
Quality of Service commitments. 

Near Real Time. Not a report type, strictly speaking. Provides utilization, error, and discard 
data for active interfaces, trunks, and EtherChannels; the time period begins with the most 
recent poll and goes back six hours; drill-down to daily and monthly data.

QuickView. Offers a detailed look at PVC endpoints, ports, or SVCs over three time periods: 
the previous day, the past month, and the past six hours. Shows the ten elements with the 
highest daily average utilization and the highest number of call attempts. 
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Snapshot. A subset of the QuickView. When you launch a QuickView, you see tables showing 
the ten most utilized PVCs, ports, or SVCs. When you launch a Snapshot, a dialog box lets you 
select specific PVCs, ports, or SVCs for analysis. Launch a QuickView to see the bigger 
picture. Launch a Snapshot when you know in advance which elements you want to analyze.

Top Ten. Shows PVC endpoints, or ports, based on highest utilized direction; the worst 
performers with the severest problems. The port report shows the utilization for each PVC 
endpoint on that port; the SVC report looks at call attempts and calls per second.

Options for Customizing Reports

You can customize reports by importing customers and locations, applying group filters, 
editing parameters, editing tables and graphs, and adding details about PVC parameters, 
QoS parameters, and ports. Service providers, or any organization that wants to share reports 
with customers, use group filters to produce customer-specific reports. Edits to parameters, 
tables, and graphs are temporary changes that anyone can make. For details about editing 
tables and graphs (selecting view options) see Appendix C, Editing Tables and Graphs.

Group Filters

If you want to share reports with customers, you have to configure OVPI to produce 
customer-specific reports. Here is an overview of the steps involved:

• Use Common Property Tables to import customer names and device locations

• Create a group account for all the users affiliated with each customer

• Create a group filter for each group account

For more information about group filters, refer to the OVPI Administration Guide. 

Editing Parameters

When you edit a parameter, you apply a constraint to the report. The constraint eliminates 
the data you are not interested in. For example, if you edit the Customer Name parameter, 
data for every customer except the customer you typed in the Customer Name field will drop 
from the report, and if you edit the Location parameter, data for all locations except the 
location you typed in the Location field will drop from the report. 

The ATM Report Pack supports the following parameters: 

• Device

• Port Name

• VPI 

• VCI

• Customer 

• Location

If you are using the Web Access Server to view reports remotely, edit parameters by clicking 
the edit parameters icon at the bottom right-hand corner of the report. When the Edit 
Parameters window opens, enter the constraint in the field and click Submit. 
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If you are using Report Viewer, select Edit > Parameter Values from the menu bar. When the 
Modify Parameter Values window opens, click the Current Value field. Type a new value and 
click OK.

Importing Properties

Provisioning for the ATM Report Pack is handled by a built-in property import utility. Use 
this utility to populate reports with the following information:

• Customer names and customer IDs

• Regions and region IDs

• Ingress and egress Quality of Service values

• Peak cell rate and sustained cell rate values

• Port speed

If the datapipe you are using supplies these values, you do not need to use the property import 
utility to import them. However, if the datapipe you are using does not supply them—or if the 
data supplied is incorrect—then you must use the property import utility to import correct 
values. If you want to update existing information, you have the option of editing a file (a file 
you exported from OVPI), or using the PVC, QoS, and port change forms.

Sources for Additional Information

This user guide contains samples of some of the reports in the package. The demo package 
that comes with the report pack contains samples of every report in the package. If you have 
access to the demo package and you want to know what fully-populated reports look like, 
install the demo package. Like real reports, demo reports are interactive. Unlike real reports, 
demo reports are static.

For information regarding the latest enhancements and any known issues affecting this 
package, refer to ATM Report Pack Release Notes. You may be interested in the following 
documents as well: 

• ATM ifEntry Datapipe User Guide

• Cisco ATM Datapipe Release Notes

• Common Property Tables User Guide

• Interface Reporting Report Pack User Guide

• Interface Discovery Datatpipe User Guide

• Thresholds Module User Guide

• NNM/PI Integration User Guide

Manuals for OVPI, and manuals for the reporting solutions and shared packages that run on 
OVPI, can be downloaded from this site:

http://ovweb.external.hp.com/lpe/doc_serv/
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The user guides for OVPI are listed under Performance Insight. The user guides for report 
packs and datapipes are listed under Performance Insight Report Packs. Each user guide entry 
indicates the date. If the guide is revised and reposted, the date will change. Since we post 
revised manuals on a regular basis, be sure to compare the date on your PDF to the date of the 
PDF on this web site and download the web edition if it is newer.
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2 The Upgrade Install
This chapter covers the following topics: 

• Guidelines for a Smooth Upgrade

• Upgrading to Version 3.3

• Package Removal

If you are installing the ATM Report Pack for the first time, this chapter does not apply to 
you. See Chapter 3, The New Install.

Guidelines for a Smooth Upgrade

When you insert the report pack CD in the CD-ROM drive and launch the package extraction 
program, the install script extracts every package from the CD and copies the results to the 
Packages directory on your system. When the extract finishes, the install script prompts you 
to launch Performance Insight and start Package Manager. Before running Package Manager, 
review the following guidelines:

• Prerequisites for the ATM Report Pack

• Upgrading Common Property Tables

• Datapipes and Remote Pollers

• Custom Table Views

• Upgrading ATM in a Distributed Environment

Prerequisites for the ATM Report Pack

Make sure the following software is already installed before upgrading to ATM 3.30:

• OVPI 5.30

• All service packs available for OVPI 5.30

• Interface Reporting Report Pack 5.30

• Common Property Tables 3.7

• ATM Report Pack 3.2
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Upgrading Common Property Tables

If you are running version 3.5 or earlier of Common Property Tables, upgrade to version 3.6 by 
installing the upgrade package. When you install the upgrade package, do not install other 
packages. Install the upgrade package for Common Property Tables and only the upgrade 
package for Common Property Tables. 

Datapipes and Remote Pollers

If you uninstall an existing datapipe, the following information is lost:

• Single polling policy for a remote poller

• Cloned polling policies for multiple remote pollers

• Customized polling groups 

To prevent this information from being lost, you can use the following commands to export 
existing polling policy configurations and customized polling groups:

• collection_manager

• group_manager 

Exporting Polling Policy Configurations

If your environment contains polling policies for remote pollers, use the collection_manager 
command to export existing policy configurations to a file. 

UNIX: As user trendadm, run the following command: 

cd $DPIPE_HOME

./bin/collection_manager -export -file /tmp/savePollingPolicy.lst

Windows: As Administrator, launch a command window. Navigate to the OVPI install 
directory and execute the following command: 

bin\collection_manager -export -file \temp\savePollingPolicy.lst

Exporting Polling Group Configurations

If your environment contains customized polling groups, use the group_manager command to 
export groups to individual .xml files. 

UNIX: As user trendadm, execute the following command: 

cd $DPIPE_HOME

./bin/group_manager -export_all -outfile /tmp/savePollingGroups

Windows: As Administrator, launch a command window, then navigate to the OVPI install 
directory and execute the following command: 

bin\group_manager -export_all -outfile \temp\savePollingGroups
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Custom Table Views

If you are using table views you created yourself, the views you created may interfere with the 
report pack upgrade, causing the upgrade to fail. Whether or not your views interfere with the 
upgrade process depends on how you created them. If you used SQL to create them, the 
upgrade will succeed, however, your custom views will not be available once the upgrade is 
complete. If you used Datapipe Manager to create them, the upgrade is likely to fail. To 
prevent the upgrade from failing, delete custom table views before you upgrade the report 
pack, then recreate those views after the report pack is upgraded.

Upgrading ATM in a Distributed Environment

Following is an overview of the installation procedure for a distributed environment:

1 Disable trendcopy on the central server.

2 For the central server:

• Upgrade to Common Property Tables 3.7; deploy reports.

• Upgrade to the latest release of Interface Reporting; deploy reports

• Upgrade to ATM 3.3; deploy reports.

3 For each satellite server:

• Upgrade to Common Property Tables 3.7 or higher

• Upgrade to the latest release of Interface Reporting.

• Upgrade to ATM 3.3.

• Remove the following datapipes:

— ATM IfEntry Datapipe 1.2

— Cisco ATM Datapipe 3.1 (if installed)

— Fore ATM Datapipe 3.0 (if installed).

• Install the following datapipes:

— ATM IfEntry Datapipe 1.3

— Cisco ATM Datapipe 3.2

— Fore ATM Datapipe 3.1

— Fore ATM Channel Datapipe 3.0.

4 Re-enable trendcopy on the central server.

5 Reconfigure your central and satellite servers.

When the previous version of ATM was installed, the person who installed it had to set up 
connections with satellite server databases, configure trendcopy commands, and switch off 
aggregations above the hourly level at each satellite server. If you just upgraded to OVPI 5.3 
and installed ATM 3.3, the server configuration changes that were made must be redone. For 
details about reconfiguring your central and satellite servers, see Chapter 4, Setting Up a 
Distributed System.
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Upgrading to Version 3.3

Perform the following tasks to upgrade from any earlier version to version 3.2:

• Task 1: Stop OVPI Timer and extract packages from the report pack CD

• Task 2: Upgrade to Common Property Tables 3.7

• Task 3: Upgrade to Interface Reporting 5.3

• Task 4: Install UPGRADE_ATM_Checker

• Task 5: Install the UPGRADE_ATM_21_to_33 upgrade package

• Task 6: Remove ATM IfEntry Datapipe 1.2, Cisco ATM Datapipe 3.1 (if installed), and 
Fore ATM Datapipe 3.0 (if installed)

• Task 7: Install Cisco ATM Datapipe 3.2, Fore ATM Datapipe 3.1, and Fore ATM Channel 
Datapipe 3.0

• Task 8: Restart OVPI Timer

Task 1: Stop OVPI Timer and extract packages from the report pack CD

1 Log in to the system. On UNIX systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services.

b Select OVPI Timer from the list of services.

c From the Action menu, select Stop.

On UNIX, as root, do one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer stop

Sun: sh /etc/init.d/ovpi_timer stop

3 Insert the report pack CD in the CD-ROM drive. On Windows, a Main Menu opens 
automatically; on UNIX, mount the CD if the CD does not mount automatically, navigate 
to the top level directory on the CD, and run the ./setup command. 

4 Type 1 in the choice field and press Enter. The install script displays a percentage complete 
bar. When the copy is complete, the install script starts Package Manager. The Package 
Manager welcome window opens.

If you navigate to the Packages directory on your system, you will see the following folders 
under the ATM folder:

• ATM.ap

• ATM_Demo.ap

• UPGRADE_ATM_21_to_33.ap

• UPGRADE_ATM_Checker.ap
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Task 2: Upgrade to Common Property Tables 3.7

Follow these rules:

• Do not install any other package with the Common Property Tables upgrade package; 
install the Common Property Tables upgrade package and only the Common Property 
Tables upgrade package. 

• When prompted to accept or disable the option to Deploy Reports, accept the default. If 
you do not deploy reports, you will not deploy the change forms that come with Common 
Property Tables.

• When the install finishes, click Done to return to the Management Console.

If you need more help with this task, refer to the Common Property Tables User Guide.

Task 3: Upgrade to Interface Reporting 5.3

1 If you have not already upgraded to Interface Reporting 5.3, install the 
UPGRADE_Interface_Reporting_to_53 package.

2 Upgrade the Interface Reporting datapipes.

a If you have one of the following datapipes installed, remove your existing version and 
install the latest version (version 2.4) if it is not already installed:

— Interface Discovery Datapipe 1.1 / 2.0 / 2.1 / 2.2

— Interface Reporting ifEntry Datapipe 1.1 / 2.0 / 2.1 / 2.2

b If you have the following datapipes installed, you must upgrade to version 2.4 if you 
have not already upgraded to version 2.4:

— Interface Discovery Datapipe 2.3

— Interface Reporting ifEntry Datapipe 2.3 

Refer to the Interface Reporting Report Pack User Guide for more information about the 
upgrade procedure.

When the new datapipes are installed, click Done to return to the Management Console.

Task 4: Install UPGRADE_ATM_Checker

1 From the Management Console, select Tools > Package Manager. The Package Manager 
welcome window opens.

2 Click Next. The Package Location window opens.

3 Click Install. 

4 Click Next. The Report Deployment window opens. Accept the defaults for Deploy Reports, 
Application Server, and Port. Type your user name and password for the OVPI 
Application Server. 

5 Click Next. The Package Selection window opens. 

6 Click the check box next to the following package:

UPGRADE_ATM_Checker

7 Click Next. The Type Discovery window opens. Disable the default.

8 Click Next. The Selection Summary window opens

9 Click Install. The Installation Progress window opens and the install begins. When the 
install finishes, a package install complete message appears. 
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10 Click Done.

11 Navigate to DPIPE_HOME/temp. Review the contents of the output file: 

check_ATM_Property_consistency.out 

12 Fix any errors.

Task 5: Install the UPGRADE_ATM_21_to_33 upgrade package

1 Start Package Manager. The Package Manager welcome window opens.

2 Click Next. The Package Location window opens.

3 Click Install.

4 Click Next. The Report Deployment window opens. Accept the defaults for Deploy Reports, 
Application Server, and Port. Type your user name and password for the OVPI 
Application Server. 

5 Click Next. The Package Selection window opens. 

6 Click the check box next to the following package: UPGRADE_ATM_21_to_33

7 Click Next. The Type Discovery window opens. Disable the default.

8 Click Next. The Selection Summary window opens

9 Click Install. The Installation Progress window opens and the install begins. When the 
install finishes, a package install complete message appears. 

10 Click Done. 

Task 6: Remove ATM IfEntry Datapipe 1.2, Cisco ATM Datapipe 3.1 (if installed), and Fore ATM Datapipe 3.0 (if 
installed)

The ATM IfEntry, Cisco ATM, and Fore ATM Datapipes cannot be upgraded. You must 
remove the existing datapipes and then install ATM IfEntry Datapipe 1.3, Cisco ATM 
Datapipe 3.2, and Fore ATM Datapipe 3.1. Start Package Manager and follow the on-screen 
instructions for package removal. When Package Manager tells you that removal is complete, 
click Done to return to the Management Console. 

Task 7: Install Cisco ATM Datapipe 3.2, Fore ATM Datapipe 3.1, and Fore ATM Channel Datapipe 3.0 

1 Start Package Manager. The Package Manager welcome window opens.

2 Click Next. The Package Location window opens.

3 Click Install.

4 Click Next. The Report Deployment window opens; disable the default for Deploy Reports.

5 Click Next. The Package Selection window opens. 

6 Click the check box next to the following package:

Cisco ATM Datapipe 3.2

Do not be surprised if the UPGRADE package you just installed has 
disappeard from view. Package Manager will display what you just installed 
as ATM Report Pack 3.30. This is not an error.

The Cisco ATM Datapipe requires the ATM ifEntry Datapipe; Package 
Manager will install the ATM ifEntry Datapipe for you. 
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Fore ATM Datapipe 3.1

Fore ATM Channel Datapipe 3.0

7 Click Next. The Type Discovery window opens. 

8 Click Next. The Selection Summary window opens.

9 Click Install. The Installation Progress window opens and the install begins. When the 
install finishes, the package installation complete message appears.

10 Click Done.

Task 8: Restart OVPI Timer 

On Windows, do the following:

1 Select Control Panel > Administrative Tools > Services.

2 Select OVPI Timer from the list of services.

3 From the Action menu, select Start.

On UNIX, as root, do one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start

Post-Upgrade Steps

Reconfigure any polling policies and customized group definitions that need to be restored. Do 
not re-import the configurations you exported. Since the old datapipe may be incompatible 
with the new datapipe you just installed, re-importing the configurations you exported could 
lead to data corruption. In addition, if you removed any custom table views before upgrading 
the report pack, you can recreate those custom table views now.

Package Removal 

Follow these steps to uninstall ATM 3.30. Removing ATM 3.30 will automatically remove any 
datapipe used by ATM 3.30.

1 Log in to the system. On UNIX systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

3 Select Management Console > Package Manager. A welcome window opens.

4 Click Next. The Package Location window opens.

5 Click Uninstall.

6 Click Next. The Report Undeployment window opens.

7 If ATM reports were deployed from this server, accept the defaults for Undeploy Reports, 
Application Server Name, and Port. If ATM reports were not deployed from this server, 
clear the check box and skip to step 9.

8 Type your username and password for the OVPI Application Server.
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9 Click Next. The Package Selection window opens. 

10 Click the check box next to the following packages:

ATM 3.30 

ATM_Demo 3.03

11 Click OK. 

12 Click Next. The Selection Summary window opens. 

13 Click Uninstall. The Progress window opens and the removal process begins. When the 
uninstall process is complete, a package removal complete message appears. 

14 Click Done.

15 Restart OVPI Timer.

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services.

b Select OVPI Timer from the list of services.

c From the Action menu, select Start.

On UNIX, as root, do one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start
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3 The New Install
This chapter covers the following topics: 

• Guidelines for a smooth installation

• Installing ATM 3.30

• Accessing deployed reports; seeing performance data in reports

• Package removal

Guidelines for a Smooth Install

An OVPI reporting solution has at least two ingredients, a report pack and a datapipe. Some 
reporting solutions offer multiple datapipes. By installing a datapipe, you configure OVPI to 
poll individual devices or read flat files created by a preprocessor. By installing a report pack, 
you configure OVPI to summarize and aggregate data collected by the datapipe.

The report pack CD contains report packs, datapipes, shared packages, and documentation. 
When you insert the report pack CD in the CD-ROM drive and launch the package extraction 
program, the install script extracts every package from the CD and copies the results to the 
Packages directory on your system. When the extract finishes, the install script prompts you 
to launch Performance Insight and start Package Manager. Before running Package Manager, 
review the following guidelines.

Prerequisites

Make sure the following software is already installed before installing the ATM Report Pack:

• OVPI 5.30

• Any and all service packs available for OVPI 5.30

• Interface Reporting Report Pack 5.30

• Common Property Tables 3.70

Upgrading Common Property Tables

If you are running an older version of Common Property Tables, upgrade your version to 
version 3.6. If you are not running any version of Common Property Tables, let Package 
Manager install Common Property Tables for you.

Do not install an upgrade package for Common Property Tables and other packages at the 
same time. Install the upgrade package for Common Property Tables and only the upgrade 
package for Common Property Tables. For more information about installing and using 
Common Property Tables, refer to the Common Property Tables User Guide.
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Distributed Environments

If you intend to run the ATM Report Pack in a distributed environment, every server must be 
running OVPI 5.30 and all available Service Packs for OVPI 5.30. Here is an outline of the 
procedure for installing ATM 3.30 in a distributed environment:

1 Disable trendcopy on the central server.

2 For the central server:

• Install Common Property Tables 3.70

• Install Interface Reporting 5.30

• Install the ATM Report Pack; deploy reports.

3 For each satellite server:

• Install Common Property Tables 3.70

• Install Interface Reporting 5.30

• Install ATM Report Pack 3.30; if you want local reporting, deploy reports, otherwise, 
do not deploy reports

• Install at least one datapipe.

4 Re-enable trendcopy on the central server.

5 Reconfigure your central and satellite servers. For details, see Chapter 4, Setting Up a 
Distributed System.

Installing ATM 3.30

This section covers the following tasks:

• Task 1: Stop OVPI Timer and extract packages from the report pack CD

• Task 2: Upgrade Common Property Tables

• Task 3: Install these packages:

— ATM 3.30

— At least one ATM datapipe

— Interface Reporting 5.30

• Task 4: Restart OVPI Timer

Task 1: Stop OVPI Timer and extract packages from the report pack CD

1 Log in to the system. On UNIX systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services.

b Select OVPI Timer from the list of services.

c From the Action menu, select Stop.
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On UNIX, as root, do one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer stop

Sun: sh /etc/init.d/ovpi_timer stop

3 Insert the report pack CD in the CD-ROM drive. On Windows, a Main Menu displays 
automatically; on UNIX, mount the CD, navigate to the top-level directory for the CD 
drive, and type the setup command. 

4 Select OVPI report packs by typing 1 in the choice field and pressing Enter. The install 
script displays a percentage complete bar. When extraction finishes, the install script 
starts Package Manager. The Package Manager welcome window opens.

If you navigate to the Packages directory on your system, you will see the following folders 
under the ATM folder:

• ATM.ap

• ATM_Demo.ap

• UPGRADE_ATM_21_to_33.ap

• UPGRADE_ATM_Checker.ap

Ignore the upgrade packages. Installing the demo package is optional. You may install just 
the demo package, by itself, or you may install the demo package along with everything else.

Task 2: Upgrade Common Property Tables

If you are running an older version of Common Property Tables, upgrade to Common Property 
Tables 3.70. Observe these rules:

• Do not install any other package with the upgrade package; install the Common Property 
Tables upgrade package and only the Common Property Tables upgrade package. 

• Accept the default for Deploy Reports. If you do not deploy reports, you will not get the 
forms that come with Common Property Tables.

• When Package Manager indicates the upgrade installation is complete, click Done to 
return to the Management Console.

If you need help with the upgrade, refer to the Common Property Tables User Guide. 

Task 3: Install ATM and at least one datapipe

1 From the Management Console, select Tools > Package Manager. The Package Manager 
welcome window opens.

2 Click Next. The Package Location window opens.

3 Click Install. 

4 Click Next. The Report Deployment window opens. Accept the default for Deploy Reports; 
accept the default for application server name and port. Type your username and 
password for the OVPI Application Server. 

5 Click Next. The Package Selection window opens. 

6 Click the check box next to the following packages:

ATM 3.30 

Interface Reporting 5.30

ATM_Demo 3.30 [optional]
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7 Click the check box next to at least one of the following packages:

Cisco ATM Datapipe 3.2

Ascend ATM Datapipe 3.00

Fore ATM Datapipe 3.10

Fore ATM Channel Datapipe 3.00

Stratacom ATM Datapipe 3.00

Newbridge ATM Datapipe 3.00

8 Click Next. The Type Discovery window opens. 

9 To run Type Discovery immediately after package installation, accept the default and 
click Next. The Selection Summary window opens.

10 Click Install. The Installation Progress window opens and the install process begins. When 
the install finishes, a package install complete message appears. 

11 Click Done to return to the Management Console. 

Task 4: Restart OVPI Timer

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services.

b Select OVPI Timer from the list of services.

c From the Action menu, select Start.

On UNIX, as root, do one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start

Accessing Deployed Reports

When you installed the ATM Report Pack, you enabled the Deploy Reports option. As a result, 
the reports in this package (as well as any forms that come with the package) were deployed 
to the OVPI Application Server. Once reports and forms are deployed to the OVPI Application 
Server, you have two ways to view them:

• OVPI clients

• Web browser

If the client applications are installed on your system, you have access to Report Viewer, 
Report Builder, and the Management Console. If the client components are not installed on 
your system, using a web browser to view reports is the only way you can view reports.

For more information about the client applications, see the OVPI Installation Guide. For more 
information about the Management Console, including how to use the Object/Property 
Management view to open reports for a selected object, see the OVPI Administration Guide.

The Cisco ATM Datapipe requires the ATM ifEntry Datapipe; Package 
Manager will install the ATM ifEntry Datapipe for you. The ATM ifEntry 
Datapipe supports directed-instance polling.
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Seeing Performance Data in Reports

Some reports populate with data sooner than others. The first report to populate with data is 
the Near Real Time report. You will see data in this report within a few hours of installation. 
Other reports, including any report that begins with an analysis of yesterday’s performance, 
will need at least one full day’s worth of data before results are available. Although capacity 
planning and forecast reports will begin to populate with data right away, reliable forecasting 
depends on a complete baseline, which takes about six weeks to produce.

Package Removal 

Follow these steps to uninstall ATM. Removing ATM will automatically remove any datapipe 
that is collecting data for ATM.

1 Log in to the system. On UNIX systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

To stop OVPI Timer on Windows, do the following:

a Select Control Panel > Administrative Tools > Services.

b Select OVPI Timer from the list of services.

c From the Action menu, select Stop.

To stop OVPI Timer on UNIX, do one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer stop

Sun: sh /etc/init.d/ovpi_timer stop

3 Start Package Manager. The Package Manager welcome window opens.

4 Click Next. The Package Location window opens.

5 Click Uninstall.

6 Click Next. The Report Undeployment window opens.

7 If ATM reports were deployed from this server, accept the defaults for Undeploy Reports, 
Application Server Name, and Port. If ATM reports were not deployed from this server, 
clear the check box and skip to step 9.

8 Type the username and password for the OVPI Application Server.

9 Click Next. The Package Selection window opens. 

10 Click the check box next to ATM 3.30.

11 Click OK. 

12 Click Next. The Selection Summary window opens. 

13 Click Uninstall. The Progress window opens and the removal process begins. When the 
uninstall process is complete, a package removal complete message appears. 

14 Click Done to return to the Management Console.
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15 Restart OVPI Timer.

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services.

b Select OVPI Timer from the list of services.

c From the Action menu, select Start.

On UNIX, as root, do one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start
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4 Setting Up a Distributed System
These are the steps to follow when setting up a distributed system:

• Decide whether or not you want local reporting

• Install the right set of packages on each server (a central server that is not polling will not 
need datapipes; the satellite servers will need datapipes)

• Register each satellite server

• Verify that the system clocks in your environment are synchronized

• If you are not copying rate data to the central server, enable LIR on the central server

• If you enable LIR, add LIR mapping with the time type set to rate

• Verify that you have all the copy policies you need

• Configure the central server (manual edits to trendtimer.sched and .pro files)

• Configure each satellite server (manual edits to trendtimer.sched and .pro files)

If you want to set up a distributed system, you can implement local reporting or you can 
implement centralized reporting. If you want local reporting, you need to deploy reports when 
you install the report pack on each satellite server, and you need to allow summarizations to 
run on each satellite server. If you do not want local reporting, then you do not need to deploy 
reports when you install a report pack on a satellite server and you can disable the scripts 
that run summarizations on each satellite server.

Before Location Independent Reporting (LIR) was available, our recommendation to anyone 
setting up a distributed system was to deploy reports on satellite servers, keep rate data on 
satellite servers, copy hourly data to the central server, and disable summarizations above the 
hourly level on satellite servers. The advantage to this approach was that it kept a large 
volume of rate data off the network and it decreased the processing load on the central server. 
The disadvantage is that the central server could not display a Near Real Time (NRT) report. 
The only NRT report was a local NRT report, on a satellite server. LIR overcomes this 
disadvantage. If you enable LIR, you can open an NRT report on the central server and 
drill-down on table selections. The selections you make cause the central server to query a 
satellite server for locally aggregated data. Of course, if you would rather copy rate data to the 
central server, you can. If you do that, then enabling LIR is not necessary.

Several report packs in the October 2007 release include a copy policy enhancement based on 
a copy policy import file. This file contains a list of data tables. When you install a report pack 
that has this file, the core product will generate copy policies automatically. As a result, you 
do not need to use the Managment Console to create copy policies. Instead, your only task 
related to copy policies is to verify that the copy policies you need already exist. 

Because you are likely to have multiple satellite servers, we designed the hourly process files 
to be satellite-server friendly. This means that most of the time, most of the defaults are 
correct. But some defaults will be incorrect, or less than optimal, and to improve performance, 
you should change them. These manual edits, as well as the other steps listed above, are 
spelled out in detail below.
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Verifying Package Installation

Before configuring servers, verify that you have installed packages correctly. The central 
server requires the following packages:

• ATM 3.30, with reports deployed

• Interface Reporting 5.30, with reports deployed

• Common Property Tables 3.70, with reports (forms) deployed

Satellite servers require the following packages:

• ATM 3.30

• Interface Reporting 5.30

• Common Property Tables 3.70

• At least one of the following datapipes:

— Ascend ATM Datapipe 3.00

— Fore ATM Datapipe 3.10

— Fore ATM Channel Datapipe 3.00

— Cisco ATM Datapipe 3.20

— Stratacom ATM Datapipe 3.00

— Newbridge ATM Datapipe 3.00

Typically, the central server does not poll. If you want the central server in your system to 
poll, install datapipes on the central server. You may deploy reports from satellite servers, but 
only if you want to view reports from satellite servers. If you do not want local reporting, then 
deploying reports is not necessary.

Configuring the Central Server

To configure the central server, perform the following tasks:

• Task 1: Register the satellite server by setting the database role

• Task 2: If you are not copying rate data to the central, enable LIR

• Task 3: If you enable LIR, add LIR mappings

• Task 4: Verify that you have all the copy policies you need

• Task 5: Modify the trendtimer.sched file

Task 1: Register the satellite server by setting the database role

1 Start the Management Console (log on with Administrator privileges).

2 Click the Systems icon in the navigation pane.

3 Navigate to the OVPI Databases folder and select the database system.

This datapipe requires the ATM ifEntry Datapipe 1.30.
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4 Click Database Properties.

5 From the Database Role list, select the Satellite Server role.

6 Enter any information necessary to configure the Satellite Server role.

Task 2: If you do not want to copy rate data from satellites to the central, enable LIR

1 Start the Management Console (log on with Administrator privileges).

2 Click the Systems icon in the navigation pane.

3 Navigate to the OVPI Databases folder and select the central server.

4 Click LIR Configuration.

5 Select the LIR enabled check box.

Task 3: If you enable LIR, add LIR mappings

1 Start the Management Console (log on with Administrator privileges).

2 Click the Systems icon in the navigation pane.

3 Navigate to the OVPI Databases folder and select the central server.

4 Click LIR Configuration.

5 Click Add Mapping.

6 From the Select Satellite Server list, select a satellite server to which to add a mapping.

7 Select the Category data table option.

8 Select ATM from the drop down list.

9 Select the rate data type.

10 Click Add to List.

11 If you want to add additional LIR mappings, click Add Mapping and repeat step 6 through 
step 10.

12 Click OK.

13 Click Apply.

A copy policy is automatically generated for the hourly data and for each LIR mapping that 
you add. The data type selected when adding an LIR mapping (in step 9 above) determines 
the type of data copied (defined in the generated copy policy). The type of data copied (defined 
in the generated copy policy) is one summarization level greater than the data type selected in 
the LIR mapping. For example, if you select an hourly data type, you will generate a daily 
data copy policy.

Task 4: Verify that you have all the copy policies you need

Verify that a copy policy has been generated for the following tables and that the copy type is 
set correctly (to Property and Data):

1 Start the Management Console (log on with Administrator privileges).

2 Click the Copy Policy icon in the navigation pane to start the Copy Policy Manager.

To add a new database reference, you can use the Add Database Reference Wizard in the 
System and Network Administration application.
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3 Find the following tables and verify the copy type is set to Property and Data for each 
table:

• SHatm_pvc

• SHatm_port

• SHatm_svc

If a copy policy has not been generated for a table, do the following:

1 Click the New Copy Policy icon or select File > New Copy Policy from the Copy Policy 
Manager. The Copy Policy Wizard displays.

2 Click Next. The Satellite Server and Copy Policy Selection Page displays.

3 Select a satellite server from the pull down list. This is the satellite server from which 
data is copied to the central server.

4 Select Single Table and select the table from the pull down list.

5 Click Next. The Copy Type Selection Page displays.

6 Select Property and Data.

7 Click Next. The Summary page displays.

8 Verify the information in the summary window. If the information is not correct, you can 
modify it by clicking Back.

9 Click Finish.

10 Repeat step 4 - step 9 for all missing tables.

If the copy type is not set to Property and Data, do the following:

1 Double-click the copy policy.

2 Select the Property and Data copy type.

3 Click OK.

Task 5: Modify the trendtimer.sched file

The trendtimer.sched file is found here:

{DPIPE_HOME}/lib/ directory 

where {DPIPE_HOME} is the directory in which OVPI is installed.

Make the following change to this file:

• Find and commen-out the following line:

1:00+40 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/ATM_Hourly.pro

Configuring Satellite Servers

Follow these steps to configure each satellite server.

1 Modify the {DPIPE_HOME}/lib/trendtimer.sched file (where {DPIPE_HOME} is the 
directory in which OVPI is installed) by switching off interface aggregations above the 
hourly level. 

• Find and comment out the following line:
32 Chapter 4



her 
RT 
24:00+3:00 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/ATM_Daily.pro  

• Modify the hourly trendtimer entry. The default is 40 minutes after the hour. Change 
the start time to 25 minutes after the hour. Changing the start time will prevent the 
central server from trying to copy data from satellite servers just when the satellite 
servers are beginning their summarizations.

2 Modify the {DPIPE_HOME}/scripts/ATM_trendsum_hourly.pro file (where 
{DPIPE_HOME} is the directory in which OVPI is installed) by enabling the trendcopy 
commands to push data to the central server. Uncomment all trendcopy commands.

3 Using Table Manager, reduce the retention period of all ATM tables to a maximum of 2 
days. 

4 Configure polling policies for each datapipe, taking care that each node is being polled by 
one datapipe on one server.

• If remote pollers are being used, avoid duplicate polling across the pollers or between 
the satellite and the pollers. 

• If a satellite server has two or more remote pollers, create separate polling policies for 
each poller and use view groups to separate the devices. 

System Clocks

Make sure that the system clock on each satellite server is synchronized with the system clock 
on the central server.

If you want the server to perform a local reporting function, do not switch off the hig
aggregations. Switching off the higher aggregations disables everything except the N
reports.
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5 Adding Properties to Reports
There are three property import files that must be produced in accordance with the naming 
and file-layout formats defined by the ATM Report Pack. The files are: 

• ATM_Port_Property.dat

• ATM_PVC_Property.dat

• ATM_SVC_Property.dat

There are three ways to produce property import files:

• Export the data you need from a network provisioning system

• Export existing property data from OVPI

• Create the files yourself

This chapter covers the following topics: 

• The property import utility

• Creating your own property import files

• Changing the default run time

Property Import Utility

Provisioning for the ATM Report Pack is handled by a property import utility packaged with 
the report pack. Use this utility to populate reports with the following information:

• Customer names and customer IDs

• Regions and region IDs

• Ingress and egress Quality of Service values

• Peak cell rate and sustained cell rate values

• Port speed

If you want to produce reports tailored to one customer or region, you must use the property 
import utility to import customer and region information. If you are operating an enterprise 
network, you have the option of importing information about each division of the company, 
treating each division as though it were a customer.

Whether or not you need to import Quality of Service, cell rate, and Port speed values depends 
on the datapipe you are using. If the datapipe provides these values, you will not need to use 
the property import utility to import these values. However, if the datapipe you installed does 
not provide this information—or if the data that it provides is incorrect—you must use the 
property import utility to import correct values. 
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To calculate utilization, OVPI requires values for the following attributes:

• PCR

• SCR

• Port Speed

PCR and SCR values are used by OVPI to determine peak and sustained cell utilization. Port 
speed is used by OVPI to determine port utilization.

Exporting Data from a Network Provisioning System

Exporting data from a network provisioning system is the easiest of the three options for 
creating the property import files. If this method is available, most of your work is already 
done.

Follow these steps to export data from a network provisioning system:

1 Create three property import files and name each file correctly.

2 Write a script to output the necessary fields.

3 Place your property import files in the directory where OVPI expects to find them. 

When the daily import process runs, the property import utility will import the information 
from the property data files into the property tables. 

Exporting Files from OVPI

Exporting property data from OVPI is an option only if property information already exists in 
property tables. Initially, there will be no property data to export. 

The export process does not run automatically. You initiate it manually any time that you 
want to update a property table or create an entry in the trendtimer_sched file. The export 
process generates tab-delimited, time-stamped property data files and puts the files in the 
default PropertyData directory. You can then edit each file in WordPad or a spreadsheet 
application such as Microsoft Excel. 

Can you simply leave the original property import files in the PropertyData directory, edit 
them as needed, and then run the import process to load the updates? No. Since your 
datapipes may be discovering new elements and updating certain fields in the property tables, 
your original property import files will be outdated.

Export Procedure

Follow these steps to export property information from OVPI:

1 Go to a command prompt line at the system level.

2 In the {DPIPE_HOME}/scripts directory, type:

trend_proc -f ATM_exportdata.pro 

When exporting customer data from a provisioning system, the dsi_target_name and 
dsi_table_key must match what the collector (ee_collect or mw_collect) has as the 
dsi_target_name and dsi_table_key.

If you bring the data into a spreadsheet program, be sure to save the file in the proper 
tab-delimited format. 
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The export program does the following:

• Reads a definition file to determine which columns to export from the property tables

• Exports data from K_atm_pvc, K_atm_port, and K_atm_svc into the directory that 
has been designated to hold the export files

The files contain one row for each object. If no objects have been discovered—that is, if no 
polling cycle has been completed yet and the property tables are empty—the files do not 
contain any rows. 

• Generates the following tab-delimited property data files and places them in the 
default directory:

— ATM_PVC_Property.dat.timestamp

— ATM_Port_Property.dat.timestamp

— ATM_SVC_Property.dat.timestamp

3 Edit these files according to the guidelines in Editing a Property Data File below.

4 Place the property data files in the directory where OVPI expects to find them: 

DPIPE_HOME/data/PropertyData 

5 You may run the import process manually, ahead of schedule, or wait for the same process 
to run automatically. If you want to run the process manually, enter the following 
command in the in the {DPIPE_HOME}/scripts directory:

trend_proc -f ATM_importdata.pro 

Editing a Property Data File

When editing a property data file, observe these guidelines:

• Use every column that the format dictates.

• Do not modify the sequence of columns.

• Do not use quotes.

• Do not use NULL values. 

• Make sure that the property data columns of dsi_target_name and dsi_table_key match 
the values of dsi_target_name and dsi_table_key in the property table. 

• The prop_PortName must be the same value that the datapipe inserts for dsi_table_key 
into the property table when collecting data for the Port statistics.

• Set the values of the *_id values to -2 (the default), if you are not using some or all of 
them. If you are not using region_id, set the value for region_id in your file to -2. 

• Use the following file naming convention: ATM_element_Property.dat

Place your file in this directory:

{DPIPE_HOME}/data/PropertyData 

If you have a dsi_target_name of atmSwitch2 with a dsi_table_key value of 
145 in your property file, there must be a matching dsi_target_name of 
atmSwitch2 with a dsi_table_key value of 145 in the property table. 
Otherwise, a new row and keyid value will be inserted into the property table.
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Creating Your Own Property Import File

If export from a network provisioning database is not an option for you, and there is no 
property data to export from OVPI, you must create the files manually and save them to the 
proper directory. It does not matter which spreadsheet application you use to create these 
files. However, you must save the results as ASCII tab-delimited files. 

The ATM Report Pack includes sample property data files in the PropertyData directory. Use 
these files for guidance in creating your own property import files. From left to right, the 
columns in the sample files are as follows:

1 dsi_target_name 

2 dsi_table_key

3 prop_description

4 prop_PortSpeed 

5 prop_PortType

6 prop_cust_id

7 prop_region_id

8 prop_region_name

9 prop_customer_name

If the sample file shows data in the region and customer columns, the user wants to see 
performance data by region as well as by customer.

Required Utilization Values

OVPI is unable to calculate utilization unless various utilization values are available. If the 
datapipe does not provide these values, or if the values provided by the datapipe are incorrect, 
you must add these values to your property import files and then import them.

PVC utilization cannot be calculated unless the following values are available:

• prop_SCR

• prop_RevSCR

• prop_PCR

• prop_RevPCR

Port utilization cannot be calculated unless the prop_PortSpeed value is available. 

Although you can modify the properties of an existing PVC, port, or SVC, you should not 
modify dsi_target_name or dsi_table_key, because these values are used by OVPI to identify 
the PVC, port, or SVC. If you change them, they will no longer match existing values in the 
property tables, causing the SQL update script to add a new row to the property table instead 
of modifying an existing row. 
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File Formats and Reserved Values

This section describes the format of the following files:

• ATM_PVC_Property.dat

• ATM_Port_Property.dat

• ATM_SVC_Property.dat

ATM_PVC_Property.dat

The following table shows the sequence of columns in the PVC property import file and 
provides a definition for each column value.

Column Definition

dsi_target_name Device name or IP address.

dsi_table_key Device index: a unique value based on how the 
device is indexed or summarized.

prop_description Customer definable field that is used in des_descr.

prop_ATMQoSNumber Database value: integer 
Required by the ReportPack. 
Enumerated Value for Class Name of Ingress QoS.
-2 = Unassigned QoS (default)
1 = CBR
2 = VBR-RT
3 = VBR-NRT
4 = ABR
5 = UBR

prop_RevATMQoSNumber Database value: integer 
Required by the ReportPack. If not set uses the value 
from ATMQoSNumber.
Enumerated Value for Class of Egress QoS
-2 = Unassigned QoS (default)
1 = CBR
2 = VBR-RT
3 = VBR-NRT
4 = ABR
5 = UBR

prop_SCR Database value: float
Required by the ReportPack if applicable.
Sustained cell rate on the egress direction.
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prop_RevSCR Database value: float
Required by the ReportPack if applicable. If not set 
uses the value from SCR.
Sustained cell rate on the ingress direction.

prop_PCR Database value: float
Required by the ReportPack if applicable.
Peak cell rate on the egress direction.

prop_RevPCR Database value: float
Required by the ReportPack if applicable. If not set 
uses the value from PCR.
Peak cell rate on the ingress direction.

prop_VPI Database value: float
Virtual Path Identifier.

prop_VCI Database value: float
Virtual Channel Identifier.

prop_ATMPVCNumber Database value: integer
1 - ATM Channel
2 = ATM Path
-2 = Unknown (default)

prop_PortSpeed Not required for PVC endpoints.
Database value: float
Port speed in bits per second for the ingress 
direction.

prop_PortType Database value: varchar (128)
Port type (UNI, NNI, ICI, etc.) for the ingress 
direction.

prop_PortName Database value: varchar (128)
Required by the ReportPack. Should be supplied by 
the DataPipe.
The port on which the PVC endpoint resides. This 
value should match the prop_PortName value in the 
K_atm_port table associated with the same device 
and port that the PVC endpoint is located on.

prop_PortDescription Database value: varchar (128)
User definable.

prop_cust_id Database value: integer
Required by the ReportPack.
Unique integer value for each customer. Assigned a 
default value of -2 when first populated.

Column Definition
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ATM_Port_Property.dat

The following table shows the sequence of columns in the port property data file and provides 
a definition for each column value.  

prop_region_id Database value: integer
Required by the ReportPack.
Unique integer value for each region. Assigned a 
default value of -2 when first populated.

prop_region_name Database value: varchar (128)
Required by the ReportPack.
Region name associated with region_id value.

customer_name Database value: varchar (128)
Required by the ReportPack.
Customer name associated with cust_id.

Column Definition

Column Definition

dsi_target_name Device name or IP address.

dsi_table_key Device index: a unique value based on how the 
device is indexed or summarized.

prop_description Customer definable field that is used in des_descr.

prop_PortSpeed Database value: float
Required by the ReportPack.
Port speed in bits per second for the ingress 
direction.

prop_PortType Database value: varchar (128)
Port type (UNI, NNI, ICI, etc.) for the ingress 
direction.

prop_PortName Database value: varchar (128)
Required by the ReportPack. Should be supplied by 
the DataPipe.
The port value. This value should match the 
dsi_table_key listed above.

prop_PortDescription Database value: varchar (128)
User definable.

prop_cust_id Database value: integer
Required by the ReportPack.
Unique integer value for each customer. Assigned 
default value of -2 when first populated.
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ATM_SVC_Property.dat File

The following table shows the sequence of columns in the SVC property data file and provides 
a definition for each column value. 

prop_region_id Database value: integer
Required by the ReportPack.
Unique integer value for each region. Assigned default 
value of -2 when first populated.

prop_region_name Database value: varchar (128)
Required by the ReportPack.
Region name associated with region_id value.

prop_customer_name Database value: varchar (128)
Required by the ReportPack.
Customer name associated with cust_id.

Column Definition

Column Definition

dsi_target_name Device name or IP address.

dsi_table_key Device index: a unique value based on how the 
device is indexed or summarized.

prop_description Customer definable field that is used in des_descr.

prop_PortType Database value: varchar (128)
Port type (UNI, NNI, ICI, etc.) for the ingress 
direction.

prop_PortName Database value: varchar (128)
Required by the ReportPack. Should be supplied by 
the DataPipe.
The port value. This value should match the 
dsi_table_key listed above.

prop_PortDescription Database value: varchar (128)
User definable.

prop_cust_id Database value: integer
Required by the ReportPack.
Unique integer value for each customer. Assigned 
default value of -2 when first populated.

prop_region_id Database value: integer
Required by the ReportPack.
Unique integer value for each region. Assigned 
default value of -2 when first populated.
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Reserved Values

Certain values for region_id and cust_id are reserved. The following table indicates which 
values are reserved 

Import Procedure 

To import information from the property data files to the property tables in OVPI, run the 
import process manually or let the import process run automatically. To run the import 
process manually:

1 Navigate to the {DPIPE_HOME}/scripts directory. 

2 Type trend_proc -f ATM_importdata.pro to run import. 

The import process runs automatically at 4:00 a.m. If you do not want to use the default time, 
you can change it. See Changing the Default Run Time on page 44.

When the import process runs, ee_collect accesses the PropertyData directory and looks for 
property data files. If there are no files in the directory, the import process stops. If there are 
files to read, OVPI populates a set of temporary property data tables. These tables are 
truncated (replaced) daily. Once the temporary property data tables are populated, an SQL 
update script uses values in the temporary property tables to update the permanent property 
tables. 

Updating a property table can mean overwriting existing information or adding new 
information. When a row in a temporary property data table has an exact match with a row in 
a permanent property table, the update script overwrites the row in the property table. When 
a row in the temporary table has no corresponding match in a property table, two things 
happen:

• The datapipe (specifically, ee_collect) adds a new row to the property table.

• The update script adds values to the row. 

Old property data files move to the Archive directory, leaving the PropertyData directory 
empty. It remains empty until you export files from OVPI.

prop_region_name Database value: varchar (128)
Required by the ReportPack.
Region name associated with region_id value.

prop_customer_name Database value: varchar (128)
Required by the ReportPack.
Customer name associated with cust_id.

Column Definition

Column Name Reserved Value

region_id -2, -1, and 0

cust_id -2, -1, and 0
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Property Data Tables and Property Tables

The following table indicates which property data table and which property tables are 
updated by each import file.

Changing the Default Run Time

The default run time for the automatic import process is 4:00 a.m. To change the default 
setting, do this:

1 Open the trendtimer_sched file in the OVPI/lib directory. 

2 In the line that defines the interval and offset for the trend_proc that executes the 
ATM_importdata.pro command, change the offset indicator, that is, the number after the 
plus (+) sign. For example, if you change 04:00 to 18:00, the import utility will run every 
day at 6:00 p.m.

Property Data File Property Data Table Property Table 

ATM_PVC_Property.dat Ratm_pvc_property K_atm_pvc
K_atm_pvc_exec
K_atm_pvc_exec_region

ATM_Port_Property.dat Ratm_port_property K_atm_port
K_atm_port_exec
K_atm_port_exec_region

ATM_SVC_Property.dat Ratm_port_svc K_atm_svc
K_atm_svc_exec
K_atm_svc_exec_region
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6 Change Forms
ATM 3.0 includes the following change forms:

• Update ATM PVC Cell Parameters

• Update ATM QoS Parameters

• Update Port Information

You cannot assign PVCs or ports to customers or locations that Common Property Tables does 
not already recognize. Add customers and locations to Common Property Tables using the 
Create New Customer form and the Create New Location form, or by using the batch-mode 
property import that comes with Common Property Tables. For details, refer to the Common 
Property Tables 3.5 User Guide.

Update ATM PVC Cell Parameters

Follow these steps to update PVC cell parameters: 

1 Select Start > HP Software > Performance Insight > Management Console.

2 Click Objects, navigate to the interface you want to update, and select it. (Or, select a 
device in order to update all interfaces on that device.) The Update ATM PVC Cell 
Parameters form is listed under Object Specific Tasks.

3 Double-click Update ATM PVC Cell Parameters. The form opens.
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4 Modify cell parameters. Click Apply to save changes, OK to save changes and close the 
form, or Cancel to close the form without saving changes.

Update ATM QoS Parameters

Follow these steps to update QoS parameters: 

1 Select Start > HP Software > Performance Insight > Management Console.

2 Click Objects, navigate to the interface you want to update, and select it. You may also 
select a device, if you want to update all the interfaces on that device. The forms appear 
under Object Specific Tasks.

3 Double-click Update ATM QoS Parameters. The form opens.
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4 Modify QoS parameters. Click Apply to save changes, OK to save changes and close the 
form, or Cancel to close the form without saving changes.

Update Port Information

Follow these steps to update port information: 

1 Select Start > HP Software > Performance Insight > Management Console.

2 Click Objects, then navigate to and select the interface you want to update or the device 
for which you want to update one or more interfaces. The Update Port Information form is 
listed under Object Specific Tasks.

3 Double-click Update Port Information. The form opens.
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4 Modify port information. Click Apply to save changes, OK to save changes and close the 
form, or Cancel to close the form without saving changes.
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7 PVC Folder: Sample Reports
The PVC folder contains the following reports:

• Availability

• Capacity Planning: PCR Utilization (2 reports: daily and monthly)

• Capacity Planning: SCR Utilization (2 reports: daily and monthly)

• Executive Summary by Customer (2 reports: daily and monthly)

• Executive Summary by Region (2 reports: daily and monthly)

• Endpoint Configuration (2 reports: daily and monthly)

• Forecast: PCR Utilization

• Forecast: SCR Utilization

• Hot Spots (2 reports: daily and monthly)

• QuickView (3 reports: daily, monthly, and Near Real Time)

• Snapshot (3 reports: daily, monthly, and Near Real Time)

• Top Ten

See below for samples of the following reports:

• Capacity Planning: PCR Utilization - Daily

• Hot Spots - Daily

• Availability

• Executive Summary by Customer: Daily

• Top Ten

• QuickView - Near Real Time

• Forecast: PCR Utilization
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8 Port Folder: Sample Reports
The Port folder contains the following reports:

• Availability

• Configuration

• Capacity Planning

• Executive Summary by Customer (2 reports: daily and monthly)

• Executing Summary by Region (2 reports: daily and monthly)

• Forecast

• Hot Spots

• QuickView (3 reports: daily, monthly, and Near Real Time)

• Snapshot (3 reports: daily, monthly, and Near Real Time)

• Top Ten: Daily

See below for samples of the following reports:

• Capacity Planning

• Availability

• Forecast

• Hot Spots

• QuickView - Near Real Time

• QuickView - Daily

• Executive Summary by Customer - Daily

• Top Ten
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9 SVC Folder: Sample Reports
The SVC folder contains the following reports:

• Executive Summary by Customer (2 reports: daily and monthly)

• Executive Summary by Region (2 reports: daily and monthly)

• QuickView (3 reports: daily, monthly, and Near Real Time)

• Snapshot (3 reports: daily, monthly, and Near Real Time)

• Top Ten

See below for samples of the following reports:

• QuickView - Daily

• Executive Summary by Customer - Daily

• QuickView - Near Real Time

• Top Ten
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A Version History
Version Release Date Enhancements

1.0 January 2003 49 reports; 5 datapipes:
• Cisco ATM Datapipe 1.0
• Fore ATM Datapipe 1.0
• Ascend ATM Datapipe 1.0
• Newbridge ATM Datapipe 1.0
• Stratacom ATM Datapipe 1.0

2.1 October 2003 1.0_to_2.1 upgrade package

3.0 April 2004 new features:
• Oracle support
• OVPI Object Manager support
new upgrade package:
• UPGRADE_ATM_2.1_to_3.0
new datapipe and new change forms:
• ATM ifEntry Datapipe 1.0 
• Update ATM PVC Cell Parameters
• Update ATM QoS Parameters
• Update Port Information

3.0 June 2005 UPGRADE_ATM_to_3.0

3.1 May 2006 new upgrade package:
UPGRADE_ATM_3.0_to_3.1
• fixes defect QXCR1000292206 
datapipe defect fixes:
ATM ifEntry Datapipe 1.1
• fixes defect QXCR1000325427
Cisco ATM Datapipe 3.1
• fixes defect QXCR1000292192

3.2 April 2007 new features:
• Location Independent Reporting
• Supports Management Console > Copy Policy Manager

• Rate data removed from NRT reports, top table
• Object delete
 97



3.20 April 2007 new versions of existing datapipes:
• ATM ifEntry Datapipe 1.2
• Cisco ATM Datapipe 3.2
• Fore ATM Datapipe 3.1
• Fore ATM Channel Datapipe 3.0
new upgrade package:
UPGRADE_ATM_21_to_32
defect fixes:
• QXCR1000221976
• QXCR1000221980
• QXCR1000229926
• QXCR1000246298
• QXCR1000320593
• QXCR1000381650
• QXCR1000386612
• QXCR1000412939

3.30 October 2007 new feature:
• Copy Policy Enhancement
new upgrade package:
• UPGRADE_ATM_21_to_33
new version of datapipe:
• ATM ifEntry Datapipe 1.3
defect fix:
• QXCM1000422485 - datapipe mapping NULL

Version Release Date Enhancements
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B PI Report Packs
Business Technology Reporting Solution

Application Application Report Pack:
• WebLogic SPI
• WebSphere SPI

Database Database SPI Report Pack

HP Business Process Insight BPI Report Pack

HP Internet Services Internet Services Report Pack

HP Network Node Manager NNM Event & Availability Report Pack

HP Operations OVO Report Pack

HP Service Desk Help Desk Report Pack
Change Management Report Pack
SLM Integration Report Pack

IP Telephony • Cisco IP Telephony Call Detail
• Cisco IP Telephony Gateway Statistics

MPLS VPN MPLS VPN Report Pack

Networking Infrastructure Usage

• Interface Reporting
• Device Resource Report Pack

LAN/WAN Edge

• Frame Relay (SNMP only) 
• ATM (SNMP only)

WAN Core

• Frame Relay (multiple switch vendors)
• ATM (multiple switch vendors)
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Networking (continued) Traffic Profiling

• RMON II

• NetFlow Interface

• NetFlow Global View

• IP QoS Report Pack

• Class-Based QoS

Quality Assurance

• Cisco Ping Report Pack
• Service Assurance
• IP Access Rate

System Resources • System Resource Report Pack

Business Technology Reporting Solution
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C Editing Tables and Graphs
Any table or graph can be viewed in several ways. Although the default view is usually 
adequate, you can easily change to a different view. If you are using Report Viewer, right-click 
the object to open a list of view options. If you are using the Web Access Server, follow these 
steps to change the default view of a table or graph:

1 Click Preferences on the links bar.

2 Expand Reports in the navigation frame.

3 Click Viewing.

4 Select the Allow element editing box.

5 Click Apply.

6 Click the Edit icon next to the table or graph. 

View Options for Tables

Right-clicking a table, or selecting the Edit Table icon if you are using the Web Access Server, 
opens a list of table view options.

Select Set Time Period to alter the relative time period (relative to now) or set an absolute time 
period. The Set Time Period window opens.

You may shorten the period of time covered by the table from, for example, 42 days to 30 days 
or to 7 days. If you are interested in a specific period of time that starts in the past and stops 
before yesterday, click Use Absolute Time and select a Start Time and an End Time.

Select Change Constraint Values to loosen or tighten a constraint, thereby raising or lowering 
the number of elements that conform to the constraint. The Change Constraint Values 
window opens. To loosen a constraint, set the value lower; to tighten a constraint, set the 
value higher.

The Select Nodes/Interfaces allows you to change the scope of the table by limiting the table to 
specific nodes, specific interfaces, or a specific group of nodes or interfaces. The Select Node 
Selection Type window opens.
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Change Max Rows increases or decreases the number of rows in a table. The default is 50. If 
you expand the default, the table may take more time to open. If you are trending a large 
network, using the default ensures that the table opens as quickly as possible. 
View in new Frame opens the table in a Table Viewer window, shown below. If necessary, make 
the data in the table more legible by resizing the window. 

View Options for Graphs

Right-clicking a graph, or clicking the Edit Graph icon if you are using the Web Access Server, 
opens the following list of view options. 
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The following table provides details about each option.

Style Options

Select Style to display a list of seven view options for graphs.

Option Function

Set Time Period Same as the table option shown above.

Change Constraint Values Same as the table option shown above.

Select Nodes/Interfaces Same as the table option shown above.

Displayed Data For every point on a graph, display data in a 
spreadsheet.

Grid Add these to the graph:
X axis grid lines
Y axis grid lines
X and Y axis grid lines

Legend Delete or reposition the legend. 

Style See the illustrations below.

Change Max Rows... Same as the table option shown above.

Display Data Table See below.

Export Element as CSV... Same as the table option shown above.

View in New Frame Opens graph in a Graph Viewer window.

Print Graph Same as the table option shown above.
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Style > Area

The plot or bar chart changes to an area graph. While relative values and total values are 
easy to view in this format, absolute values for smaller data types may be hard to see. Click 
anywhere within a band of color to display the exact value for that location 

To shorten the time span of a graph, press SHIFT+ALT and use the left mouse button to 
highlight the time span you want to focus on. Release the mouse button to display the selected 
time span.

Style > Stacking Area

The area or plot graph changes to a stacking area graph. This view is suitable for displaying a 
small number of variables.
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Style > Bar

The graph changes to a bar chart. This view is suitable for displaying relatively equal values 
for a small number of variables. There are three variables in the graph below.

Style > Stacking Bar

The plot or area graph changes to a stacking bar chart. If you increase the width of the frame, 
the time scale becomes hourly. If you increase the height of the frame, the call volume shows 
in units of ten.
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Style > Plot

Bands of color in an area graph change to lines. If you adjust the frame width, you can make 
the data points align with hour; if you adjust the frame height, you can turn call volume into 
whole numbers.

Style > Pie

An area graph becomes a pie chart. Bands in an area graph convert to slices of a pie and the 
pie constitutes a 24-hour period. This view is helpful when a small number of data values are 
represented and you are looking at data for one day.

If you are looking at data for more than one day, you will see multiple pie graphs, one for each 
day. 
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Display Data Table

This option changes a graph into a spreadsheet. 

View in New Frame

The graph opens in a Graph Viewer window. Improve legibility by resizing the window. 
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ATM ifEntry Datapipe, 9, 20, 26, 97

ATM ifEntry Datapipe 1.0, 97

C
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Change Interface Customer (form), 46

Change Interface Description (form), 47

Change Interface Location (form), 46

Change Interface Properties (form), 45

change max rows option, 103

check_ATM_Property_consistency.out, 20

Cisco ATM Datapipe, 8, 9

collection_manager (command), 16

Common Property Tables, 19

customized data table views, 21

custom views of data or property tables, 17

D
Datapipe Manager, 17

default import process run time, 44

default run time, 44

default source directory path, 37

demo package, 12, 25

directed-instance polling, 9

discovery, 36

Display Data Table, 103

displayed data option, 103

distributed systems, 24

E
export process for property data, 36

extracting packages from the distribution CD, 24

F
Fore ATM Channel Datapipe, 8

Fore ATM Datapipe, 8

G
generic reports

Availability, 10
Capacity Planning, 10
Configuration, 10
Executive Summary, 10
Hot Spots, 10
QuickView and NRT QuickView, 10

grid options, 103

group_manager (command), 16

group accounts, 11

group filters, 11

I
importing properties, 12

import process for property data, 36

interface re-indexing, 9

L
launching reports from NNM, 11

legend options, 103

N
Network Node Manager, 11

Newbridge ATM Datapipe, 9

Newbridge Preprocessor, 9

O
OVPI Timer

starting, 21
stopping, 18

P
PCR (peak cell rate), 12, 35
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polling policies, 16, 21

property data files
creating the files manually, 38
editing guidelines, 37
example of, 38
export command, 36
exporting from a network provisioning system, 

36
format of ATM_Port_Property.dat, 41
format of ATM_SVC_Property.dat, 42
generating the files, 35
import command, 43
names of, 35
required utilization values, 38
reserved values, 42

property import datapipe, 12, 35

provisioning, 12, 35

R
report parameters, 11

S
SCR (sustained cell rate), 12, 35

SHIRDevPorts table, 33

Stratacom ATM Datapipe, 9

Stratacom Preprocessor, 9

style options for graphs, 103

T
Table Manager, 33

U
updating property information, 36, 43

UPGRADE_ATM_Checker, 18, 19, 25

upgrading Common Property Tables, 23

Use Absolute Time, 101

V
version history, 11

view in new frame, 102
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